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NCSA Mosaic ™ for Microsoft Windows

Welcome to the Mosaic for Microsoft Windows Home Page.
Mosaic 15 a World Wide Web client that was developed at the
National Center for Supercomputing Applications on the campus
of The Umversity of Illnois in Urbana-Champaign.
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NCSA Mosaic is an Internet navigation and data retrieval tool. It will allow you to access
network information with the click of a mouse button. Mosaic is capable of accessing data from
World Wide Web servers (HTTP), Gopher servers, FTP servers and Usenet News servers
(NNTP). Mosaic can also access other data services through gateway servers. These services
provide search capabilities in database environments such as PH, Archie, WAIS, and Veronica.
NCSA Mosaic provides transparent access to these information sources and services. NCSA
Mosaic software is copyright The Board of Trustees of the University of Illinois (UI), and
ownership remains with the Ul The UI grants you a license without a fee to use the Mosaic
software for personal, academic, research, government and internal business purposes.

Mosaic operates under Microsoft Windows on one of the following processor architectures.
Windows 3.1x, Windows for Workgroups 3.1x, Windows 95, Windows NT 3.5x

Intel 1X86 - Intel's 386, 486, and Pentium processors

Windows NT 3.5x



DEC aXP - Digital Equipment Corporation (DEC) aXP 64-bit processor
MIPS PC - Mips Technology processor
Power PC - Motorola, IBM, Apple Power PC processor



File Menu Commands

Mosaic Help is context sensitive, click on the area where you need help:

Open Document...
Open Local File... Ctrl+L
Save As... Ctrl+5
Save as Text

Print... Ctrl+P
Print Preview
Print Setup...

Newsgroups...
Send Email...

Document Source...

Exit




Open Document...
Opens a dialog box where you enter the address of a document. Presently these
addresses are in the form of a URL:

(protocol://machine.name/directory/path/filename.html)

Select the green check to load the document or the red X to abort the request.



Open Local File...
Opens a standard Windows Open dialog box that lets you open a file on your local
system. Select the desired HTML or ASCII file and select OK to load the
document.



Save As...
Opens a standard Windows Save As dialog box that lets you save the current
document in its original format (i.e., HTML or ASCII).



Save As Text
Opens the Save As Text dialog box that lets you save the current document in
ASCII format, omitting the inline images and table information that may be
included in the document.



Print
Opens a Print dialog box, that displays the status of your current printer and the
print range. Select OK to print the current document.



Print Preview
Mosaic displays the current document in a preview format. Within print preview
there are several functions that allow you to view the present document as it will
appear on the printer. Select Print... to print the document, or Close to close
print preview.



Print Setup
Opens a dialog box that allows you to configure the define or configure the
settings of the printer.



Newsgroups
Displays the list of subscribed newsgroups in the Mosaic document view
Window.



Send Email
Opens the Mail... dialog box. Enter the address of the receiver, the subject, and
content of the mail message. You can include the URL of the current document,
the text of the current document, include a file using the Import File feature and
append a signature file to the end of the mail message with a click of the button.
Select Send and Mosaic send the mail message to the mail server you defined
in your Preferences, Services menu. Select Abort to cancel the email message.



Document Source
Opens the Document Source window, which displays the source file of the
current document. Most are in HTML format, but some files are ASCII.
The document source window has two menus (File and Edit). The File menu,
has a Save function that allows you to save the source file. The Edit menu,
has a Copy function that allows you to copy information from the file to the
Windows Clipboard.



Exit
Closes the window and exits NCSA Mosaic.



Edit Menu Commands

Mosaic Help is context sensitive, click on the area where you need help:

Paste Ctrl+¥

Find...
Select All




Copy
Copies the selected text to the clipboard. Text can be selected from the document
view window, document location bar, the document source window, and
text-entry fields in various interactive windows (e.g., the Open Document...
window ).



Paste
Pastes the selected text to the current cursor position. Text can be pasted into
the document location bar , text-entry fields in various interactive windows
(e.g., Open Document...) , and into forms within the document view window.



Find...
Opens the Find dialog box. Enter the characters, words, or phrases you want to
search for in the current document. Click Find Next to begin search. If you

want your search to be case sensitive, make certain the Match Case box is
checked.



Select All
Selects all the text in the Document View Window. Select copy from the Edit
menu or from the tool bar to copy all text to the clipboard.



Options Menu Commands

The first four entries on the Options menu are toggles--if a check mark appears

before the item, it is on or active. If no check mark appears, the function is turned
off or inactive.

Mosaic Help is context sensitive, click on the area where you need help:

Options

+ Show Toolbar Alt+T
+ Show Status Bar A4S
+/ Show Location Bar Alt+U

Presentation Mode Alt+P

Preferences...




Show Toolbar
When checked, the Toolbar is active and appears below the menu bar. The
toolbar offers easy access to several funtions: Save to Disk, Save to Disk, Print,
Print Preview, Back, Forward, Reload, Load Home Page, Find, Save to Hotlist,
Read Newsgroups, Send Internet Mail, and About.



Show Status Bar
When Show Status Bar is active, the status bar is displayed at the bottom of the
Mosaic window. The status bar contains three areas, Text status, Graphic status,
and a Download indicator. Select the status bar on the main page for more
information.



Show Location Bar
When checked, the Location Bar is displayed under the Toolbar if it is active or
under the Menu bar if the Toolbar is not active. The location bar has a few
functions: The X allows you to cancel an entry in the location field and it
returns the field to the origional document address. Selecting the Check
submits the current address and prompts Mosaic to load the document. The
location field displays the address of the current document. The location field
also allows you to enter an address to a document in the form of a URL. The
arrow button opens a list box that contains a list of the document addresses visited
during the current Mosaic session.



Presentation Mode
Expands the document view field to a full screen view. By default the title bar,
menu bar, tool bar, location bar, and status bar are turned off. You can toggle the
tool bar, Location bar and status bar on and off using Alt + T, Alt +L, and Alt +S
respectively. Alt-P toggles the presentation mode on and off..



Navigate Menu Commands
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Forward F

Beload
Home

I3

History
Add Current To Hotlist
Hotlist Manager...




Back
Moves back one document in the history list. Dimmed when there is no previous
document.



Forward
Moves forward one document in the history list. Dimmed when the current
document is the last one in the history list.



Reload
Reloads the current document.



Home
Loads the document defined in the Options, Preferences, General, Home Page
field. See the documentation for more information about setting a home page.



History
Opens a window that contains a tree history of the document addresses (URLSs).
The current document is highlighted and you can move to any other document in
the list by doubleclicking on the address.



Add Current to Hotlist
Adds the title and URL of the current document to the hotlist that is defined
in the Hotlist Managers Add to: field.



Hotlist Manager Loads the document defined in the Options, Preferences, General, Home
Page
field. See the documentation for more information about setting a home page.

Opens the Hotlist Manager window where you manage the elements within your
hotlist.



Annotate Menu Commands

Mosaic Help is context sensitive, click on the area where you need help:

Annotate
Annotate

Edit this annotation
Delete this annotation

See online documentation on Mosaic homepage for a more information on annotations.



Annotate
Opens an annotations window that allows you to add, edit, view or delete
annotations to the document in Mosaics document view window.



Edit This Annotation
Opens the NCSA Mosaic Annotate window to allow you to edit (or delete) the
annotation currently being viewed. This menu entry is only active when you are
viewing an annotation.



Delete This Annotation
Deletes the annotation that is currently being viewed. This menu entry is only
active when you are viewing an annotation.



Hotlists

Hotlists are user defined shortcuts to World Wide Web documents. By default
we provide a list of documents that we thought would be interesting to the Mosaic
user group. See the documentation for Hotlist Manager for more information
about configuring the list of document titles and addresses.



Help Menu Commands

Mosaic Help is context sensitive, click on the area where you need help:

Help
Contents

Search for Help On
How to Use Help

Online Documentation
FAQ Page

Bug List

Feature Page

About Windows Mosaic...
Mail Technical Support...




Contents
Opens the first page of the Mosaic context sensitive help page.



Search on Help
Opens a search window relative to Mosaic Help



How To Use Help
Opens the standard Windows Help tutorial.



Online Documentation
Links to the NCSA Mosaic for Microsoft Windows Online
User's Guide.



FAQ Page
Links to the online FAQ page.



Bug List
Links to the online Bug List.



Feature Page
Links to the online Feature List, which includes current features description in
detail.



About Windows Mosaic
Opens a Document View window displaying the current version information,
copyright statement, and a list of the current developers.



Mail Technical Support
Opens a Document View window so you can email to the NCSA Mosaic for
Windows technical support staff. You can automatically include your system



@ Open Document...
Opens a dialog box where you enter the address of a document. Presently these
addresses are in the form of a URL:

(protocol://machine.name/directory/path/filename.html)

Select the green check to load the document or the red X to abort the request.



. Save As

Opens a standard Windows Save As dialog box that lets you save the current
document in its original format (i.e., HTML or ASCII).



Print

Opens a Print dialog box, that displays the status of your current printer and the
print range. Select OK to print the current document.



@ Print Preview
Mosaic displays the current document in a preview format. Within print preview
there are several functions that allow you to view the present document as it will
appear on the printer. Select Print... to print the document, or Close to close
print preview.



Copy

Copies the selected text to the clipboard. Text can be selected from the document
view window, document location bar, the document source window, and
text-entry fields in various interactive windows (e.g., the Open Document...
window ).



Paste

Pastes the selected text to the current cursor position. Text can be pasted into
the document location bar , text-entry fields in various interactive windows
(e.g., Open Document...) , and into forms within the document view window.



E Back

Moves back one document in the history list. Dimmed when there is no previous
document.



E Forward
Moves forward one document in the history list. Dimmed when the current
document is the last one in the history list.



@ Reload

Reloads the current document.



@ Home

Loads the document defined in the Options, Preferences, General, Home Page
field. See the documentation for more information about setting a home page.



Find...

Opens the Find dialog box. Enter the characters, words, or phrases you want to
search for in the current document. Click Find Next to begin search. If you
want your search to be case sensitive, make certain the Match Case box is
checked.



Add Current to Hotlist
Adds the title and URL of the current document to the hotlist that is defined
in the Hotlist Managers Add to: field.



Newsgroups

Displays the list of subscribed newsgroups in the Mosaic document view
Window



Send Email

Opens the Mail... dialog box. Enter the address of the receiver, the subject, and
content of the mail message. You can include the URL of the current document,
the text of the current document, include a file using the Import File feature and
append a signature file to the end of the mail message with a click of the button.
Select Send and Mosaic send the mail message to the mail server you defined
in your Preferences, Services menu. Select Abort to cancel the email message.



About Windows Mosaic
Opens the Mosaic Help Contents Page. (This page... )



@ Retrieving/Interrupt
The animated Mosaic logo acts as a visual indicator letting you know when
Mosaic is busy downloading a file and as an download interupt. Click on the
Mosaic logo or press Esc on the keyboard to cancel a file request.



Location Bar
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The location bar has a few functions: The X allows you to cancel an entry in

the location field and it returns the field to the origional document address.
Selecting the Check submits the current address and prompts Mosaic to load the
document. The location field displays the address of the current document. The
location field also allows you to enter an address to a document in the form of a
URL. The arrow button opens a list box that contains a list of the document
addresses visited during the current Mosaic session.



E: or

® Disconnected/Connected
A visual indicator to show whether Mosaic is waiting for the information server to
respond or it has made a connection to the server.

M Disk Cache
Indicates that the requested HTML document is being pulled from the disk cache
and not from the associated information server.



Z or

2 Waiting/Reading
A visual indicator to show whether Mosaic is waiting to receive the required file
or is currently reading data from the information server.



® Image Loading
A visual indicator that appears when inline images are a part of a document.
To the right of the image icon appears the number of inline images associated
with the current document. This number decreases as the inline image files are
received and loaded into the page.



BRI NNEEAE Progress Meter
The Mosaic progress indicator is a visual aid to help you determine the amount of
bytes received for a file. One hundred percent of the file has been received when
the indicator is full.



Text Status
Reports messages concerning connectivity to the information server and the status
of a file download while Mosaic is trying to retrieve. While Mosaic is idle, the
text status area displays the document address of a link when the mouse pointer
is placed over a hyperlink.



Image Anchor
An inline image that links to other information. Inline image achors are
denoted by a border that has the same color as the text anchors. Click on
the anchor to link to the information.



Text Anchor
A word(s) that link to other information.



Title Bar
The title bar displays both the title of the application and the title of the currently
displayed document.



System Menu
Opens the standard Windows system menu.



Minimize/Maximize
The down arrow minimizes the Mosaic window and the up arrow maximizes the
window to fit the entire screen.



Preferences Dialog Box
General
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-Home Page
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Show Toolbar
When checked, the toolbar appears on startup.

Show Location Bar
When checked, the location bar appears on startup.

Show Status Bar
When checked, the status bar appears at the bottom of the Mosaic window
on startup.



Display Inline Images
When checked, inline images appear within a document. When blank, inline
images and background images are not shown. Instead, the position of an inline
image is marked with a image icon and if it is available, alternate text is displayed.

3D Borders
Provides a three-dimensional borders around inlined images.



Lets you choose a new background color for the document window.



3D Rules
Show Horizontal Rules, <HR>, three-dimensional lines instead of solid
black line.

Round List Bullets
Displays a 3D bullet at the beginning of each list item instead of a dash

Use Internal (8 Bit) Sound
Converts audio/basic (.au) files to 8 bits before sending them to the sound
device. This option is overridden if a viewer is defined.



Identify your home page URL here. The page is loaded on startup if
the Autoloadbox is checked.



Set the default position and size of the Mosaic window on startup.
Click Use Current Window Position to use the current position and
size as the default.



Display Text while Loading
If checked, displays the document while it is being downloaded.

Display Images While Loading
If checked, displays inline images after they are downloaded.

Disable Display While Loading
If checked, Mosaic waits until the document and all images are
downloaded before they are displayed.

Use <BODY> Attributes
Display the HTML 3.0 <BODY> tag attributes. In particular, the background
image tags.



Preferences Dialog Box
Viewers

Mosaic Help is context sensitive, click on the area where you need help:

NCSA Mosaic for Microsoft Windows can use other applications to display file types such as,
Microsoft Word, Postscript, MPEG movies, quicktime movie, Image, etc.  These applications
can be commercial software, shareware, freeware or copyright software and we refer to them as
external viewers. In general, if an application can accept command line inputs, Mosaic can use
it as an external viewer. When Mosaic downloads a file that it cannot display, Mosaic can pass
the file to an external viewer and this application will display the file to you. For example, if you
have Microsoft Word, you can configure Mosaic to pass all files that have the MIME
(Multipurpose Internet Mail Extension) type of application/msword or files extended with .doc
to your Microsoft Word application.

For more information about MIME types, available viewers and configuring Mosaic to use
specific viewers, see the following URL:

http://www.ncsa.uiuc.edu/SDG/Software/ WinMosaic/viewers.htm

Use this preference page to configure your applications as external viewers. The following
fields can be edited but do so with caution. If you have problems with a MIME/Viewer
configuration, check the appropriate MIME type for typos. You can find a list of MIME types
from the above URL. Editing the information in these fields will change your current viewer
configuration.

Aszzociate MIME Type of:
Iaudiu.ﬂ'au

Description of MIME Type [Optional):
|Audio File Format - WAVE

With thiz/these extensions:
I _Wave, wav, WAY

To Thiz Application:
I-:::kwinapps\wplany\wplany.Exe Browsze.__. I

| Add I | Hemove I

(1] 4 I | Cancel I | Apply How I | Help I







Associate MIME Type of:
Displays the MIME types and subtypes. Click on the arrow button to view the
current list of MIME types.

CAUTION: If you edit information in this field, it will change your view configuration.



Description of MIME Type (Optional):
A description of the MIME type displayed in the above field.



With This/These Extensions:
Enter the file extension(s) associated with the MIME type displayed in
the Associate MIME Type of: field.



To this Application:
Enter the path and the executable name of the external viewer. Make certain the
application software is capable of handling the MIME type. Use the Browse...
function to create this association.

Browse...
Opens the standard Windows tree format dialog box for viewing your
directories and files. Find the appropriate application software and click OK.
Mosaic then fills in the appropriate information in the To this Application: field.



Add
Click to add a new MIME type and associated information to your MIME type
list.

Remove

Click to delete the current MIME type and all associated information from your
MIME type list.



Preferences Dialog Box
Services
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Mozaic Tech Support




Name:
Enter your name.
E-mail Address:
Enter your email address
SMTP:
Enter the name of your mail server.



Use Extended FTP
Associates a meaningful icons with directories and file-types. Mosaic also
displays the size for each file on an FTP server. When blank, Mosaic will only
display the names of the files and/or directories.

Display FTP Messages
Mosaic opens a dialog box listing the messages generated by the FTP server.



Display Options offers three ways of handling news offerings. Select one from
among the three choices:

Thread View
Display the top level messages without reply messages.
Group View
Display the top level message and the first level of replies.
Tree View
Display the top level and all replies in hierarchical format. (Replies to replies are
represented at different levels of the hierarchy.)



Load All Articles:
When checked Mosaic loads all available news article headers for the newsgroup
you select in Mosaics News interface. This feature disables the Number of
articles to display: feature.

Number of articles to load:
Number of news article headers you want Mosaic to retrieve from the news server.
Number of articles to display:
Number of articles,(10-100), you want Mosaic to display in the document view
window.
NNTP Server:
Enter the name of your news server
.sig file
Enter the path to a signature,(.sig), file. A signature file is a text file that contains
contact information about you and/or your organization. This file is used when
post a message to a newsgroup or mail a message using.



Path name
Enter the path of your Telnet application, for example, c:\directory\filename.
If you are not sure about the specific path, click Browse, which opens the
standard MicrosoftWindows browse window. Find your telnet application,
click OK, and Mosaic will make the association.

Telnet applications use either a colon or a space to distinguish a specific port number.
Select one of the options based on applications your needs.
Host:port:
When selected, Mosaic uses a colon to disginguish the port number as specified
in the document URL field.
Host port:
When selected, Mosaic uses a space when you specify a port number.



Subscriptions

Mosaic Help is context sensitive, click on the area where you need help:

Mews Subscriptions

-Newsgoups

Search ||
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alt.3d
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alt_alien_vizitors
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alt_angst
alt_answers
alt_appalachian

a!t. aquaria - 3

Subzcnbed:

comp. infospstems. www_browsers. ms-windows Unselect All

| [+

Cancel




Search:
Enter the name or prefix of a newsgroup. If the newsgroup is available in the list,
Mosaic displays the newsgroup(s) after you stop typing.
Available:
Displays the names of newsgroups available from your default news server.
Update:
Click to update your list of available newsgroups from your default server.



Subscribe:
Adds selected newsgroups from the Available field to the Subscribed field.
Select a newsgroup from the Available list, click Subscribe to move the
newsgroup to the Subscribed list.

Unsubscribe:
Deletes selected newsgroups from the Subscribed list to the Available list.
Select a newsgroup from the Subscribed list then click on Unsubscribe to
move the newsgroup to the Available list.



Select All:
Selects every entry in either the Available field or the Subscribed field
depending on the location of your cursor.

Unselect All:
Deselects the entries that were selected.



Subscribed:
Displays the list of the newsgroups you selected.



Preferences Dialog Box
Proxy

Mosaic Help is context sensitive, click on the area where you need help:

Firewalls are employed by many organizations to protect their local area networks from intruders
and to prevent unauthorized employees from leaving the LAN. Unfortunately, firewalls also
prevent NCSA Mosaic from directly retrieving documents over the Internet with out the use of a
proxy gateway.

A proxy gateway allows Mosaic to request information from outside the firewall. The proxy
gateway (or proxy server) receives an Internet request (in the form of a URL) from a Mosaic
application running inside the firewall. The proxy gateway then makes the request to the
Internet and sends the information back to the requesting Mosaic session behind the firewall.
Thus network requests are handled exclusively by the proxy server because it is usually the only
machine connected to the Internet. Users behind a firewall should feel directly connected to the
Internet.

Proxy gateway support in NCSA Mosaic for Microsoft Windows is currently implemented on a
per access method basis, which means different URL access methods may send requests to
different proxy servers. Current access methods are ftp, gopher, wais, and http. Requests to ftp
sites may go through one proxy server while requests to a web server may go to another.

Configure proxy gateway support using this preferences menu.

General | iewers | Services | | Anchors | Fontz I Cache | Apdio |

HTTF Proxy Server:

WAIS Proxy Server:

|
FTP Proxy Server: I
|
|

Gopher Proxy Server:

Machine/Doman List:
proxy all others

Bemove
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=%
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Enter the name of the machine that is providing you with proxy services in each field (HTTP
Proxy Server, FTP Proxy Server, WAIS Proxy Server, Gopher Proxy Server). If the same
machine provides you with services for more than one protocol, enter that name in each field. If
you have no proxy services for a listed protocol, leave the field blank.

For example:

HTTP Proxy Server: name.of.your.firewall. machine:portnumber

or

HTTP Proxy Server: proxy.ncsa.uiuc.edu:8080



Machine/Domain List:
This windows lists the network domains that are or are not affected by the proxy
services. For example, if you run a WWW server behind the firewall and you do
not want to use the proxy server to gain access to that information. Instead you
could enter the name of your subnet name and list it as no proxy. Since you are
behind a firewall, you would proxy all other domains.

Example:

no proxy ncsa.uiuc.edu
proxy all others



Add
Opens a dialog box where you to enter the domain name or the IP number of a
specific machine or domain to the Machine/Domain List (e.g., ncsa.uiuc.edu)

Remove
Removes the selected domain entry from the Machine/Domain List.

Proxy
Associates a proxy status with a selected domain; select a domain name and
then choose Proxy or No Proxy.

No Proxy
Associates a proxy status with the selected domain; select a domain name and
then choose Proxy or No Proxy.

NOTE: You can toggle the proxy/no proxy state of a domain by double clicking on the
domain name in the Machine/Domain List area.



Preferences Dialog Box
Tables
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3D Tables:
Displays all table borders as a 3D frame.
Ressessed Tables:
Inverts the 3D border frame
Display Empty Cell:
Displays empty cells instead of making them appear as part of the frame.



Red: Green: Blue:
Displays the current RGB color value of the table frame.

Change:
Opens a dialog box where you can change the color of the table frame.



Preferences Dialog Box

Anchors
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Change Cursor Over Anchor:
If checked, cursor changes from the standard arrow to a hand with a pointing
finger when the cursor is over a hyperlink or anchor.

Underlined:
If checked, all anchors are underlined. (This is particularly useful if you are using
a black and white monitor.)

Show URL in Status Bar:
If checked, the URL of an anchor is displayed in the status bar when the cursor
is on a hyperlink.

Visually Age Visited Anchors
Gradually changes the color of an anchor from the visited or cached color to the
unvisited color as the anchor gets closer to the expiration period specified.

Expire Visited Anchors:
Length of time before an anchor revert to the unvisited anchor color.



Red: Green: Blue:
Displays the RGB value for the current anchor color.

Change...
Opens a dialog box where a new color can be selected from a color palette.



Using a framed, buttoned, or hatched anchor, the left and right arrow keys
are enable for anchor navigation. The left arrow key takes you back to the previous
anchor and the right arrow will jump you to the next anchor in a document.

Framed:
Surrounds the current anchor with a solid frame.
Button:
Gives the current anchor a 3D button effect.
Hatched:
Surrounds the current anchor with a broken frame.
None:
Anchors are not modified by a frame, button, or hatched effect; anchor navigation
with the the left and right arrow keys is disabled.
Red: Green: Blue:
The current RGB color value of the anchor border.
Change...
Opens a dialog box where a new color for the anchor border can be selected from
a color palette.



Preferences Dialog Box
Fonts
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Mosaic Font Groups:
Displays the name of the font groups available to Mosaic. To view the contents
of the group double click on the group name.

Default
The default font group.



New
Opens a dialog box for entering the name of the new font group. After entering a
name in the field, click in the box to create a new group or the X to cancel the
function. The initial settings for a new font group reflect the current settings in
the default group.

Remove
Deletes the selected font group

Edit
Changes the name of the font group.

Change
Opens a dialog box to change the font type, size, or color of the selected font.



Current Font Group:
Highlight the font group from this list that Mosaic uses on start-up.
Magnification Units:
The multiplicative value (1 to 5) that is used when the screen fonts are magnified
or decreased using the + or - key.



Preferences Dialog Box
Cache

Mosaic Help is context sensitive, click on the area where you need help:
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Memory Cache

Number of documents kept in memory:
The number of documents maintained in memory cache during a Mosaic session
The memory cache is volatile.



Disk Cache

Location:
Define the drive: (\directory\path\) to the directory used to maintain the
non-volatile disk cache (e.g., c:\Mosaic\Cache\)
Size (KB):
The number of KBs allocated to the disk cache (1M = 1024KB)
Enabled:
If checked, disk cache is enabled.
Fast Image Caching:
Converts cached inlined images into a .bmp format, which increases the
pagination speed of the inlined image as they ae loaded from the disk cache.
Never purge home page:
If checked, the home page is always in the disk cache.

Clear Cache on Exiting Mosaic
Mosaic clears the disk cache when you exit the program.

Check Modification Date From Server:
If checked, Mosaic makes certain the most current version of the document is
being viewed when a document is reloaded. Mosaic does this by query the
server for the header of the document, which contains the file's size and
modification dates. If this information changes, Mosaic downloads and displays
the more recent version. If the information is static, Mosaic loads the document
from the disk cache. You can set Mosaic to check the documents once per session
or every time Mosaic loads a document.



Advanced Cache Manager

Mosaic Help is context sensitive, click on the area where you need help:

Cache Management
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Hits
The number of times the file has been hit from the cache.
Size
The size of the file.
File
The actual name of the file.
URL
The origional URL to the file.

Below this box is statistical information relative to the contents of the cache (e.g.,
total number of files, the actual size of the disk cache (KB)). The Cache Hit
Percentage shows the percentage of times you accessed the cache during the life
of the cache and during the present Mosaic session.



Cache the following mime types? is a list of the current MIME types listed in
your viewers section and the cache status for each MIME type.

Select a MIME type from the Cache the following mime types? field and click
Yes to add a type of file to your disk cache. Select a MIME type from the Cache
the following mime types? field and click No to delete a type of file from the disk
cache.



Load URL:
Select a URL from the cache management window and click to load the file.
Delete:
Deletes the selected item from the cache.
Never Purge:
Highlight an item in the cache and click this button to save the URL
permanently. [tems are marked by an asterisk (*) next to the Hits number.
Can Purge:
Highlight an item marked as Never Purge and click this button to removed the
asterisk marking the file. If Check Modification Date From Server is
checked, Mosaic updates the file the next time you visit the web site.
Clear All:
Removes the contents of the disk cache. If items are flagged Never Purge,
verify that you want to delete these items.



File:
Sorts the cache management window by the file type

Server:

Sorts files by WWW server name.
Size:

Sorts by file size.
Hits:

Sorts by the number of times the file is hit from the cache. (The first element in
the list has the highest hit percentage.)

Mime:
Sorts by MIME type.



Preferences Dialog Box
Audio

Mosaic Help is context sensitive, click on the area where you need help:
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A listing of various events that activate a specific sound within Mosaic. To see an explanation of
the various events, click here.




Events

A maximum of twenty-five Mosaic events can be associated with any of the .wav
audio files on your system. An audio tone is sent when a .wav sound file is associated with one
of the following events:

Abort
Left mouse click on the Mosaic logo or pressing the ESC key

About Box
From the Help menu, About Windows Mosaic... or the Question Mark in the
Tool Bar

Add to Hotlist

The Add to Hotlist icon in the toolbar or open the Hotlist Manager (Navigate,
Hotlist Manager) and select Edit, Add Curent at Selection Point
Load Document
Select the green check next to the URL command or press ENTER.
Navigate Back
Select the left arrow icon from the toolbar or Navigate, Back.
Cancel URL Bar
Select the red X next to the URL command line.
Copy
Select a range of text in a document and the Copy icon from the toolbar or
CTRL+C
Done Loading
Audio notification when Mosaic has received and loaded the document into the
document view window.
Find
Select the Find icon from the toolbar or Edit, Find
Navigate Forward
Select the right arrow icon from the toolbar or Navigate, Forward
History
Select Navigate, History
Home
Select the House icon from the toolbar or Navigate, Home
Image Loaded
Audio notification when Mosaic loads an image into the document view window.
Mail
Select the Mail icon from the toolbar, or use File, Send Email... or enter mailto:
name@address in the URL command line.
News
Select the News icon from the toolbar, or use File, Newsgroups... or enter
news:newsgroups into the URL command line.
Open
Select the Open URL icon from the toolbar, or by selecting File, Open URL...
(CTRL+O) or File, Open Local File... (CTRL+L)



Paste

Select the Paste icon from the toolbar or Edit, Paste (CTRL+V).
Preferences

When you select Options, Preferences...
Presentation Mode

Select Options, Presentation Mode (ALT+P)
Print

Select the Print icon from the toolbar or select Edit, Print...
Print Preview

Select the print preview icon from the toolbar or File, Print Preview...
Reload

Select the reload icon from the toolbar or Navigate, Reload
Save

Select the save icon from the toolbar or File, Save As...
Shutdown

Doubleclick on the upper left system menu or File, Exit
Startup

Mosaic greets you when you start the application.



WAV Files:

A list of all WAV files that are to be associated with a specific event.
Test

Test the highlighted WAV file by playing it back.



Sound File:
A sound scheme file that contains a listing of WAV files and their locations.
Save
Saves the current collection of events and associated sound files either in a new
specified file or over the currently listed SND file.
Load
Loads another specified SND file.









